
Making Cold Process Soap for the First Time:
How to make soap & beginner soap recipes to get you 
started!

By Rebecca D. Dillon, author Soap Deli News Blog

Whether this will be your first attempt at making homemade
cold process soaps or you're simply looking for new soap recipes
to get your feet a little wetter, following is my collection of
beginner cold process soap recipes that are relatively less
expensive to make with ingredients that are also more easily
sourced locally. After all everyone's not sure if soapmaking will
be for them. But I've found that most folks who give

soapmaking a shot are permanently hooked after creating their first successful batch. 

For those who are truly passionate about soapmaking, you'll likely find that purchasing ingredients
online and in bulk to be the most economical. Soapmaking is not what one would think of as a “cheap”
hobby as the initial cost is much greater than other hobbies such as scrapbooking or crocheting.
However, if you have problem skin of any kind, you'll find that not only is soapmaking worth the
initial start up cost, but your skin – and your friends & family's - will also benefit from what could
be your new passion.

Without lye there is no soap.

The scariest thing for me when I first started making
soap was working with lye. Lye – also known as sodium
hydroxide – is a necessary part of making homemade
soaps. Without lye, there simply is no soap. You must
have a fat – your soapmaking oils and butters – and an
alkali – sodium hydroxide – to make soap. When
combined they go through a chemical reaction called
saponification. During this process, the lye is used to
chemically change the fats into soap. If done correctly, there is never any lye left in the resulting
soap.

The only way to avoid working with lye is to buy pre-made bases. However, as I quickly discovered,
this limited the final outcome of the soaps I made. If you're looking for soaps that have specific
properties, the best way to get them is to design exactly the kind of soap you want by including
ingredients with the properties you want into your cold process soap recipe.

http://soapdelinews.com/


Yes, lye is a little scary. However, once I finally dove in and made cold process soaps for the first
time, I realized that it wasn't nearly as terrifying as I thought it would be. I've found that tutorials
on soapmaking tend to have you be overly cautious about working with lye so it seems frightening. The
truth of the matter is however, it isn't frightening as long as you have sound knowledge of what
you're doing going in, and you take simply safety precautions – just like in high school chemistry class.
So purchase some goggles, some gloves and for kicks you can also go with a fancy new rockabilly apron
just so you have some great photos to share on your social media.

Your goggles and gloves can be purchased at your local hardware store. This is also likely where you'll
find the lye you need to get started. Many hardware stores have jacked their prices on lye double
what they were a few years ago AND started keeping it behind the counter. This is due the rise in
methamphetamine use as lye is one of the ingredients used to make meth. Naturally this can make
sourcing lye a bit discouraging especially if your hardware store has chosen not to carry it at all. 

The most common brand of lye I've found locally, since grocery stores stopped carrying Red Devil Lye,
is Roebic Heavy Duty Crystal Drain Opener. It's sold in 2 lb. Containers and contains 100% lye (sodium
hydroxide, caustic soda.) There are other brands out there as well and they will suit fine as long as
they are 99% or more pure. Another alternative would be to hunt down your local soapmakers – I
networked with local soapmakers at my farmer's market – and see if they have any lye they can sell
you just to get started or can tell you where they source lye locally. 

Additionally, you can also purchase lye at various places online from chemical supply companies,
soapmaking suppliers and Amazon. I buy my lye from a local chemical supply company. While it's much
cheaper for me to purchase lye this way it does require buying in bulk. The smallest size of sodium
hydroxide pellets they offer is 55lb. However, it costs less than $40 and I can pick it up at their
warehouse. Unless you know you'll be going crazy making soap 24/7 though, I recommend paying a
little more and starting out with a much smaller quantity. 

Equipment you'll need for that first – and all those “I'm a soap addict!”
subsequent soap batches.

Now that you've sourced your lye, suited up with your goggles, gloves and that rockin' apron, you'll
need a few housewares. It's likely you already have a few of these things in your home so you're not
splurging all your funds on equipment. Because quite honestly you'll want to splurge on the ingredients
going into your soap. That's where all the fun is at. If you're off to a running start and plan to make
enough soap to wrap around the moon and back, then you might want to buy all new equipment to
keep your kitchen utensils and pots for actual food separate from the strictly soapmaking equipment.
But it's not necessary to never use your soap pot for cooking spaghetti in again. Just wash it really
well. Wash it again to ensure there's no residue and you're good to go. 



You can save some money of course by checking out second hand stores if necessary or simply desired.
Or if you have the green light from your significant other to go crazy, then I recommend you just go
crazy. 

You will need without a doubt the following: 

A digital kitchen scale that weighs in grams and ounces and
can handle some more significant weight. I have used a Baker's
Math scale for years and highly recommend it over say a
shipping scale from an office supply store as it will stay more
accurate over time and last much longer. 

A stainless steel pot for mixing your soap. You NEVER want to
use aluminum ANYTHING to make soap as this does some
pretty crazy chemistry of its own when it reacts with lye.

And it's not the chemistry we want for soapmaking. It's also pretty dangerous. Therefore if you aren't
100% certain your pot isn't aluminum, then buy one that you know is most definitely not. 

A thermometer, such as a candy thermometer, so you can accurately judge the temperature of your
lye-water and oils before you mix them together.

You'll also need a stick blender/hand blender/immersion blender. It's called many things, but it's
basically the same tool. This takes the hardest physical part of soapmaking – the mixing – out of the
equation. As a result your soap will trace faster, meaning less time you have to stand around mixing,
and it also helps to ensure an evenly mixed batch of soap. I wouldn't say any one brand is better than
another as I've had cheap stick blenders last for ages and do just as well as the more expensive ones. 

Pitchers and measuring cups! You'll need a pitcher or large Pyrex measuring cup to mix your lye-water
in as well as to weigh out ingredients. Some soapers won't use glass Pyrex measuring cups to mix the
lye-water in as it can etch the glass over time and inevitably lead to breakage. However I've had the
same thing happen with plastic pitchers over the years. So I'll leave that decision up to you. It's good
practice is to inspect your containers regularly for any signs of wear or cracking as well as to mix your
lye-water in a sink or outside in case a container does break in the process. 

You'll also want to have some handy dandy utensils like large mixing spoons and a spatula. I use a long
plastic spoon – like the wooden ones but plastic – to mix my lye water. I use a heavy duty metal
spoon to scoop out semi-solid oils and butters, and a spatula to get all of the soap out of the pot into
the mold. Occasionally I even use a knife or a grater for hard oils and butters to get them down to
size. You'll find what works best for you and likely you already have all of these things hiding in
drawers in your kitchen. 

http://amzn.to/1RexPrI
http://amzn.to/1RexPrI
http://amzn.to/1RexPrI


What about soap molds?

Finally you will need a mold for your soap. You don't need to spend a lot of money on a fancy
soapmaking mold. Your mold could be as simple as a cardboard box or a tupperware container that has
been lined with a trash bag. Alternately you could purchase a silicone loaf pan – the same kind used
in baking – or you can easily make your own wooden loaf soap mold with just a few materials from a
hardware store for next to nothing. 

I've been using wooden loaf soap molds that my
dad made me for well over a decade now. I like
the wooden molds because they are practically
indestructible. Most of my homemade soap
recipes I develop contain 36 oz. in oils and fit
perfectly inside these molds. If you'd like to
make your own wooden loaf molds you can find
the dimensions for this mold along with
instructions for making your own here.

Keep in mind however that using a wooden soap mold does require some preparation before use. While
you can pour your soap directly into a silicone mold, you must line a wooden soap mold. (The same goes
for using a tupperware container or a cardboard box.) However, for round soaps you can use an empty
Pringles can and simply peel the paper container off your soap once it's gone through the saponification
process. 

Not lining your wooden soap mold will cause your soap will get stuck and result in a lot of unnecessary
frustration. When I first started making soap, I used to cut parchment paper to line my molds.
Basically you fold the paper in a way that is similar to wrapping a present but with an open top. I've
also seen contact paper used in the same way as demonstrated in this tutorial from Inner Earth Soaps
blog. However, I found that both parchment paper and contact paper can get expensive over time. And
I also found the process for lining my soap molds this to be overly tedious and time consuming. Because
of this, and due to the stiffness and occasional pain in my hands from the fibro, I use thin,

commercial office trash bags to line my molds. (These
are rather inexpensive to purchase at places like Sam's
Club and Costco. So if you lean towards more practical
than perfect and don’t mind a few minor creases on
the sides and bottom of your soap, then this method
may be the one for you. Plus, once you've unmolded
your soap, the trash bag can still be used as an actual
trash bag.

http://innerearthsoaps.blogspot.com/2013/06/lining-your-mould-with-contact-paper.html
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To line my wooden soap mold using a trash bag, I simply unfold the bag – but don’t open it – press it
into the mold and then tape the outer edges with masking tape where the bag folds over the outside
of the mold to keep it in place. This method is gentle on hands and super quick especially if you are
lining multiple soap molds at once. Of course, how you choose to line your molds is personal
preference. I recommend doing whatever works best for you. Once your soap has set you simply lift
the soap from the mold and peel off the liner, cut into bars and allow to cure. And, if you used a
fragrance in your soap, you know have a scented trash bag for the bathroom!

Learning about soapmaking ingredients.

Now that you have your soapmaking equipment, it's time to focus on the ingredients for your soap
recipe. 

For your first attempt at making cold process soap I recommend using a tried and true soap recipe
rather than creating your own. It is helpful to know some of the basic chemistry about your
ingredients so that you can create your own homemade soap recipes in the future. Your fats – or
soapmaking oils and butters – will very much determine what properties your soap will have. For
example, three of the traditionally popular soapmaking oils, especially for beginners, are olive oil,
coconut oil, and palm oil. Olive oil helps to create a moisturizing bar with a stable lather; coconut oil
produces a hard, cleansing bar with a fluffy lather; and palm oil makes for a hard bar with a stable
lather. Each of these oils has its own SAP (or saponification) value which determines how much lye
should be used in the soap recipe for saponification to occur in such a way that it makes soap. Too
much lye and you have an unusable bar of soap. Not enough and you could end up with a really soft
soap with excess oil. 

A great source for learning more about the saponification process and the properties of various
soapmaking fats & oils is Susan Miller Cavitch’s book, The Soapmaker's Companion. Her book also
contains a great troubleshooting section to help you figure out what might have gone wrong with a
soap recipe as well as a nice collection of her own recipes. 

A little about how to create your own homemade soap recipes.

When creating your own homemade soap recipes, there are also a lot of additional free resources to
help you with this process. Lye calculators, for example, will automatically calculate the amount of lye
you need in a recipe based on the amounts and types of oils you plan to incorporate into your recipe.
You can find multiple links to lye calculators by conducting a google search. However, the lye calculator
at SoapCalc.net can help you to create a soap recipe that meets your expectations for the properties
you're looking for in your own soaps. It does this by giving recommended ranges for the various soap
qualities and fatty acids and tells you where your soap recipe falls in regards to each of these ranges.

http://soapcalc.net/
http://amzn.to/1egU5Ch


However, the soap calculator at SoapCalc.net is a bit more complex than some of the other soap
calculators available so you'll need a little more information to get started with this lye calculator.
Certainly don't let that intimidate you though. You can discover some pretty fantastic soap recipes
through trial and error.

To use the lye calc at soapcalc.net you'll need to enter a little bit of information in addition to your
ingredients. Since you'll be making cold process soap you'll need to choose the radio button for NaOH
(sodium hyroxide.) KOH or potassium hydroxide is used to make liquid soap. 

Next, choose which measurement you'll be using to weigh your oils. I recommend using either grams or
ounces. I typically weigh out my ingredients in ounces however for smaller recipes you'll find that
grams will always be the most accurate as it's a smaller unit of measure. 

Third choose your water as % of oils or the water discount. I highly encourage you to set this at 33%.
Otherwise you'll likely have a very soft soap to start out with which will not only take longer before
it can be unmolded but will also take much, much longer to cure as there's so much more excess water
that needs to evaporate. Occasionally I use less than 33% for soap recipes that are using a lot of oils
that are know for creating a softer soap. For example, a 100% olive oil soap – or what is known as a
traditional Castile soap - is going to start out as a much softer soap and requires a cure time of 4-6
months rather than 4-6 weeks. In this case I typically use 30.5% as the water discount amount. 

Next choose a superfat amount. A soap with 0% superfat has no extra oils left over in the final soap
bars once saponification is complete. To superfat a soap means you have extra fats (or oils) that are
left unsaponified in your final bars of soap. These unsaponified oils help to make soap more
conditioning. It is standard practice to use at least a 5% superfat unless you are making a laundry
soap. This saves your butt in case of small errors in measurements and keeps your soap from stripping
too much excess oil from your skin when bathing. For a more conditioning soap you would use a higher
superfat of up to 8%. However, in some situations, you may choose to use an even higher superfat
amount for personal reasons or simply because it's “good science.” 



For example coconut oil has natural cleansing properties in soap. As such it's recommended you only use
up to 30% coconut oil in your soap recipe to avoid an overly cleansing soap that will strip skin of its
natural oils. (I typically only use 20% or less as I prefer soaps that are more conditioning than
cleansing.) 100% coconut oil soaps are very cleansing which is great for making laundry soap.
However, it's not so great for skin. You can overcome this in a 100% coconut oil soap however by
superfatting your soap recipe at 20%.

There are times however, or “bad science,” that a really high superfat doesn't make sense. Coconut oil
has a very long shelf life and therefore isn't prone to going rancid. Other oils, however, have a much
shorter shelf life. Because of the higher percentage of oils left unsaponified at a superfat percentage
above 8%, they can go rancid more quickly than you might like and cause what is commonly referred
to as DOS. DOS or dreaded orange spots are basically unsaponified oils that have gone rancid. Should
this occur to any of your soaps, and sadly it sometimes does, you can salvage the soap by grating it and
using it as a laundry soap.

Next, if you are using a fragrance for your soap recipe choose your fragrance amount. Typically
fragrance oils are used at 1 oz. per pound or less and essential oils at half that amount or less.
However, this can vary depending on the type of fragrance oil or essential oil you are using. Typically
fragrance oils are used at a max of 5-6% of your recipe. Sometimes the maximum usage amount for
a cold process soap recipe is lower. In this case you'd need to refer to the manufacturer's guidelines on
the maximum amount of fragrance oil that is safe to use. For essential oils, the usage rate is typcially
between 1-3%.

Now select your soapmaking oils, fats and waxes for your soap recipe. Click on the first oil, fat or
wax you are using then click on the plus sign for the #1 spot on the Recipe Oil List. If you know the
specific oil weight you'll need for your soap recipe – say you have a 3 lb. mold – hit the lb radio
button. Enter the amount of the first oil you plan to use. 



For example, if you are making a 3 lb. batch of soap and you want to use coconut oil at 20% of your
recipe, multiply 48 ounces (if you chose the weight of the oils to be in ounces) times .2 for 9.6
ounces. Enter 9.6 in the first box. 

Now repeat with all of the remaining oils until you've reached the total oil weight of your recipe.
Click on Calculate Recipe then View or Print Recipe. Your recipe will open in a second window and give
you the amount of lye and water you'll need based on the data you entered, the amount of fragrance
oil to use and information on what the soap bar quality will yield. While it's not a hard and fast rule
that you fall within the recommended ranges of soap bar quality for hardness, cleansing, conditioning,
bubbly, creamy, iodine and INS, it's safer to stay within these ranges if you're just starting out and
learning for more successful results until you learn more through experience and further research. 



Pictured above is a test recipe I threw together as an example of what your final recipe will look like
after inputting your information into SoapCalc. Pretty neat, huh? (This lye calc has actually taught me
that both hemp seed oil and sunflower oil are high in iodine.)

FYI It is good practice to always double check the amount of lye in a recipe with a lye calculator if
you are unsure of its source.

Resizing a soap recipe.

Not using the lye calculator at SoapCalc? Other lye calculators, like the one at Brambleberry
automatically give you a more standard amount of water or liquid needed for your soap recipe. This
makes it somewhat simpler to use if you're just getting started. While it doesn't offer as many oil
choices as SoapCalc and won't give you an idea of what properties your soap will have, Brambleberry
does have a simple and easy tool to resize your soap recipe once you input it into the lye calculator.
You can learn how to re-size a cold process soap calculator using Brambleberry's lye calculator here .

Need a quick and easy way to learn to what properties the soapmaking oils you want to use have? It's
as easy as a google search! Properties and suggested amounts can be found on most soapmaking supplier
websites. So typically you can visit the website of your favorite supplier and the product page of the
ingredients you are interested in buying will tell you what properties a particular ingredient will lend
to the soap as well as the recommended amount. Alternately you can type into your search box phrases
like “properties of hemp seed oil in soap” or “recommended amount of hemp seed oil in soap” and
you'll find all kinds of valuable information. 

Summer Bee Meadow also has a simple chart for quick reference on their website that provides a
collection of commonly used oils in soapmaking along with their fatty acids and resulting soap
characteristics. Another website, Lovin' Soap Studio, has a chart with commonly used oils and the
recommended usage rates. You should also be able to determine the shelf life of your ingredients from
the manufacturer or soap supply company you purchase your ingredients from. 

Determining the amount of soap needed for your mold.

Need to re-size a soap recipe to fit into a mold but aren't sure what to scale the recipe to? There's a
simple formula for determining the weight of the soapmaking oils needed for your mold. About.com
has a formula and instructions for calculating the amount of soap needed to fill a mold here. They
give the basic math equations for determining the correct soap recipe size for standard square or
traditional molds, round or tube molds and odd or irregularly shaped molds. 

(Note that for most of my soap recipes I use my easy DIY wooden loaf soap mold unless otherwise
noted.)

http://soapdelinews.com/2013/06/how-to-make-a-soap-mold-for-cold-process-soap.html
http://candleandsoap.about.com/od/suppliers/tp/Calculating-The-Size-Amount-Of-Soap-To-Fill-A-Soap-Mold.htm
http://candleandsoap.about.com/od/suppliers/tp/Calculating-The-Size-Amount-Of-Soap-To-Fill-A-Soap-Mold.htm
http://www.lovinsoap.com/oils-chart/
http://summerbeemeadow.com/content/properties-soapmaking-oils
http://soapdelinews.com/2013/09/how-to-re-size-a-cold-process-soap-recipe.html


Getting down to business. 

Following are your basic step-by-step cold process
soapmaking instructions. However, keep in mind
these steps aren't always set in stone and
temperatures used in soapmaking can vary based
on the ingredients you've chosen for your recipe. 

1. Begin by preparing your soap mold so that it is
ready when your soap is ready to be mixed and
poured. For some recipes you will also also need to
cut out a piece of cardboard to cover the top of
your mold. The cardboard will be used to help
insulate your soap after it is made, assuming
insulating your soaps is needed for the gel phase. 

2. Once your mold is prepared measure out the amount of distilled water (or other liquid) called for
in your soap recipe in fluid ounces. (Or whatever measurement you are using for your recipe.)

3. Pour your distilled water in a non-aluminum container. This may be a sturdy plastic pitcher or a
glass Pyrex measuring cup. (If using glass be aware that lye-water can etch glass and so it should be
check periodically for cracks or excessive etching.)

4. Next, while donning your safety gear, weigh out the lye using a digital scale. Place the container
you’re using to measure the lye onto the scale, press tare to zero it out, then slowly pour the lye onto
the scale until you reach the amount needed.

Now, in a well ventilated area, slowly pour your lye into the container of distilled water. (You never
want to pour the water into the lye as it could result in a not so pleasant volcano effect.) Stir your
lye into the water with a plastic or wooden spoon until it dissolves thoroughly. Now set the lye-water
aside to cool. If you’re mixing the lye inside, keep it on the stove with the exhaust fan turned on and
step away. Or allow it to cool outside to avoid the nasty fumes. Be sure there are no children or
animals underfoot who could get hurt.

It's also important to note that lye-water gets VERY hot and can cause chemical burns. If you are
splashed with the lye-water thoroughly flush the affected area with cold water. Then use vinegar to
clean up any spills on hard surface areas.

5. While the lye is cooling, use the digital scale to weigh out the soapmaking oils, butters and waxes as
well as any other ingredients. After weighing each of my soapmaking ingredients I combine them into



a large stainless steel pot then place them on the stove over medium heat. You can also melt your oils
separately in canning jars within a water bath. This works well if you are planning to soap closer to
room temperature. 

Begin by weighing each of your soapmaking oils and butters individually. Set the container you are
using to weigh your oils onto the scale then hit tare to zero out the weight. Slowly add your first oil
to the container until you’ve reached the weight the recipe calls for. 

Repeat this process for all oils and fats in your recipe. I usually start with the solids first so I am
adding the liquids to the pot last, but that is just personal preference.

Once all the soapmaking oils are combined in your pot, place on the stovetop at medium heat until the
oils have all melted. Stir the oils and remove from heat, then set the pot of soapmaking oils aside to
cool. 

6. Once your lye-water and soapmaking oils have cooled, you are ready to make soap! I find that most
soap recipes work best when the lye-water and oils have cooled to between 90°F-100°F. However,
the temperature of the oils can vary depending on the ingredients you are using or what temperatures
the soap recipes you are using calls for. In addition, your oils should not be hotter than the lye-water.
If you aren’t sure how a recipe will react at higher temps, then it's safe to hazard a guess and soap
between 90°F-100°F. (Refer to The Soapmaker’s Companion for information on why temperatures
matter.) With your handy stick blender ready to go, very slowly pour the lye-water into the oils.

7. Begin stirring the soap ingredients with the stick blender on low. As the lye and oils begin to
incorporate, you can switch to a higher speed. Mix thoroughly, moving the blender all through the
entirety of the soap ingredients so it's evenly combined. You do not want to hold the stick blender in
just one spot while you are mixing. 

Continue to stir the soap until you reach what is known as trace. You will know your soap has traced
when you can pull the blender through the soap and it leaves a line behind it. In addition, if you lift
some of the soap up with the blender and then drop it onto the surface of the soap, the soap should be
able to support that drop. 

Should you not reach trace, within 15 minutes, you can rest for about 15 minutes, then start mixing
again. Some oils used in soapmaking are slower to trace. Virgin olive oil, for example, can take a much
longer time to trace than other oils unless it is mixed with other oils whose properties promote a quick
trace. (Alternately, pomace olive oil is known for a much quicker trace.)

8. If you are using any additives for your soap such as fragrance, herbs or colorants, you will want to
add these to your soap once has reached a light trace. A light trace just barely leaves a trail when

http://www.amazon.com/The-Soapmakers-Companion-Comprehensive-Techniques/dp/0882669656/?_encoding=UTF8&tag=rebeccassoapd-20&linkCode=ur2&camp=1789&creative=9325


running the stick blender through it. (Alternately a heavier trace is much thicker and looks a little like
pudding or custard.) 

After adding these additional ingredients use the stick blender to thoroughly mix them into the soap so
they are evenly incorporated throughout the soap. This is especially important for fragrance oils and
essential oils as you do not want any “hot spots” in your soap. (Generally fragrance oils account for 3-
6% of your soap and essential oils for 1-3%; but be sure to follow manufacturer’s recommendations
if they are available.) 

Tip: When choosing a fragrance oil or essential oil for your soap recipe, keep in mind that some
fragrances and essential oils can accelerate trace or cause soap to seize. Your supplier should be able
to provide information on how their fragrances perform in cold process soap. 

Once your additives have been thoroughly incorporated, you’re ready to pour your soap into its mold!

9. Slowly pour your soap into the prepared mold. You can use a spatula to help you get all of the soap
out of the pot. Once you've poured all of the soap into the mold, you may find it helpful to drop the
mold onto the counter several times to help remove any air bubbles.

If your soap needs to be insulated cover the mold with a piece of cardboard cut to fit. Then cover the
mold with a blanket or towel. This ensures that your soap goes through what is known as gel phase.
However, soap doesn't necessarily have to go through gel phase to make a successful batch of soap.
Some soapmakers choose to actually prevent gel phase and will freeze their soap after pouring it into
the mold. Soapqueen.com has some insightful information on the gel phase here.

If you check your soap and notice it is starting to crack on the top your soap is overheating. In this
case you will want to uncover the mold completely. 

Once your soap has been in the mold for 24 hours it is ready to be unmolded. 

10. Unmold your soap and, unless it is still
soft, go ahead and cut it into bars. (You find
information on how to make a simple loaf soap
cutting guide here.) I generally discount the
amount of water used so that my soap can
immediately be cut into bars. If you find that
your soap is on the soft side, simply wait
another day or two before unmolding and/or
cutting your soap loaf into bars. 

http://soapdelinews.com/2013/06/diy-soap-cutter-a-simple-guide-for-cutting-your-soap-into-bars.html
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Now place your soaps in a safe, dry location and allow your soap to complete the saponification process
– this typically occurs within a day or two – and allow your soap to cure fully. This generally takes a
period of 4-6 weeks. 

If you’re setting your soap to dry on a flat surface, be sure to set it on top of parchment or freezer
paper to keep any oils or moisture from seeping out of the soap into the surface of your drying space.
You can also dry your soaps on a rack. 

Properly curing your soap will not only help your soap last longer, but it also makes the soap milder on
skin and gives you a better lather. 

Once the soap has cured you can then package it to share with your friends and family! If you are
planning to sell your homemade soaps, you'll need to include the weight of the soap on each bar. 

Still have questions?

Not everyone has a successful soapmaking experience the first go around. So if you’re still cautious
after all of your research, then I recommend finding a friend who makes soap to teach you the process
or try watcing a few YouTube videos on soapmaking.

How about those soap recipes?

Following are a few of my many homemade soap recipes. Most of these soap recipes require not only a
minimal number of ingredients but also contain less expensive ingredients that are more easily sourced
locally. This is so you can get acquainted with the soapmaking process before you step up to ordering
harder to find and more expensive ingredients.



Beginner Cold Process Soap Recipe

This easy, beginner cold process soap recipe requires just three inexpensive soapmaking oils that can be
sourced at most grocery stores. I also offer several substitutions that you can use for the main
ingredient that won’t require you to recalculate the amount of lye needed. (However, it is good
practice to always recalculate for the lye in recipes where you are unsure of the source.)

The main ingredient in this beginner cold process soap recipe is palm oil. There is some controversy
within the soapmaking community regarding the use of palm oil. Primarily in Southeast Asia they tear
down the rain forest to create palm plantations. In addition to the environmental effects this has it
also threatens endangered animals like orangutans and Sumatran tigers. Some soapmakers choose not to
use palm oil at all because of this. Others choose to purchase only sustainable palm oil that is given
oversight from state and third party environmental programs such as EcoSocial and the Roundtable for
Sustainable Palm Oil.

Because palm oil is so cheap, many commercial products are made using palm oil including soaps and
stearic acid – a common ingredient in lotions. Most shortening is also made with palm oil or a
combination of palm oil and other oils.

Ultimately the decision to use or not use palm oil is a personal one. I used palm oil in this cold process
soap recipe as I have a lot of it still in my soapmaking arsenal. It also makes a great bar of soap
almost solely on its own. It is rich in vitamin E oil and antioxidants and it yields a hard, creamy soap
with a good lather.

Should you decide not to use palm oil or are unable to locate palm oil at your grocery store there are
several substitutions you can make. Lard, which is pig tallow, is the closet substitution. It barely
changes the outcome of the final soap. However, if you don’t use animal products the other option for
this particular beginner cold process soap recipe does contain palm oil. All-Vegetable Crisco contains a
combination of palm and soybean oils. It changes the final value of the fatty acid INS from 165 –
the recommended range in a recipe is 136 to 165 – to 118. Substituting either lard or Crisco for
the palm oil in your soap recipe will still yield a good basic soap and won’t require you to recalculate
the amount of lye needed for the soap recipe. (Assuming no other changes are made.)

As I prefer a really conditioning bar of soap, especially in the winter, I superfatted this recipe at
10%. Typically you’ll want to superfat between 5% (to compensate for any minor errors in the
ingredient weights) and 8%. The higher you superfat, typically the softer the soap as you are leaving a
higher percentage of soapmaking oils unsaponified. This is not the case for this recipe however as palm
oil creates a very hard bar. Although with less shelf stable oils it can also lead to the unsaponified oils
going rancid.



Easy Beginner Cold Process Soap Recipe

© Rebecca's Soap Delicatessen

Ingredients:

15 oz. palm oil
4 oz. refined coconut oil (76° melt point)
1 oz. castor oil

6.6 oz. fluid oz. distilled water
2.6 oz. lye/sodium hydroxide

1 – 1.25 oz. fragrance oil, optional

Soap Notes (in case you want to re-size the batch):

Water as % of oils was set at 33%. 

Fragrance oil used at 1 oz. per pound. For this particular recipe I used Nature’s Garden Candles Fig
Lychee fragrance oil. This particular fragrance oil contains 2% vanilla so the soap does darken as it
cures to a toffee color. To me it smells like a sweet berries in cold process soap. I’ve found that
everyone’s noses are different though.

10% super fat was used.

The oils were used at the following percentages: Palm oil=75%, Coconut oil=20% and Castor oil at
5%.

I used my Wilton silicone 6-cavity heart mold for this soap recipe. I see this particular mold at most
every local craft store I’ve been to so if you have a craft store near you it’s likely you’ll be able to
find it locally. This recipe yielded enough soap to create six heart shaped soaps with soap “icing” on
top. You don’t have to use this mold however. You can use any mold of your choice.

Instructions:

Begin by gathering all of your soapmaking equipment together. In addition to your soap mold you’ll also
need a stainless steel pot – no aluminum! – a stick blender, a digital scale, and various containers and
utensils per the soapmaking tutorial you just read. Then gear up with your safety equipment, gloves 
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and googles to protect yourself in case of any accidental spills or splashes while working with lye. 

Begin by measuring out the distilled water in fluid ounces. (I actually used 100% coconut water in my
recipe, however, it did accelerate trace. Pour the water into a pitcher.

Next, use a digital scale to weigh out your lye. Place the container you’re using to measure the lye
onto your scale, press tare to zero it out, then slowly pour the lye into your container until you reach
the amount needed.

Now slowly pour the lye into the water. Stir your lye and water with a plastic or wooden spoon until
the lye dissolves completely. Now set it aside to cool. 

While the lye is cooling, you’ll want to weigh and melt your oils. Combine the soapmaking oils into your
stainless steel pot and heat on the stove over medium heat. Be sure to keep an eye on the oil as they
can melt quickly. As soon as they have melted remove the pot from heat and allow to cool.

Once the lye-water and the soapmaking oils have cooled to between 95°F-100°F you’re ready to
make soap.

Slowly pour the lye-water into the melted oils. Then, using your stick blender mix the lye-water and
oils together. Once your soap reaches a light trace you can add a fragrance oil if desired. Mix well to
combine to a medium trace the pour the soap into your prepared mold. (My soap actually was at a
heavy trace when I put it into the molds so I spooned it in more than poured it in.)

If you want soaps like mine that have icing on top, allow the soap in the molds to reach a heavy trace
so the “icing” won’t sink into the soap. You will have a little bit of leftover soap after filling all six
of the heart mold cavities. Mix a small amount of mica, an ultramarine or oxide colorant or a natural
colorant into the remaining soap then use a spatula or butter knife to spread the remaining soap onto
the tops of all the hearts the same way you would real icing.

If desired you can also complete the look with a sprinkle of fine glitter on top of each heart after
you’ve added the icing.

Now cover your mold – I used food service film to lightly cover my mold so it wouldn’t ruin the icing
effect – and wait.

Approximately 24 hours later you can unmold your soaps. If you used a loaf mold go ahead and cut the
loaf into individual soap bars. If you made heart soaps like me there’s nothing left to do. Simply allow
your soaps to cure for 4-6 weeks before use then wrap and label as desired.

http://www.amazon.com/gp/product/B00629LVXI/ref=as_li_ss_tl?ie=UTF8&camp=1789&creative=390957&creativeASIN=B00629LVXI&linkCode=as2&tag=rebeccassoapd-20


Lemon & Poppyseed Soap Recipe

© Rebecca's Soap Delicatessen

Ingredients:

9 oz. palm kernel flakes
10.8 oz. palm oil
14.4 oz. rice bran oil
1.8 oz. castor oil

11.8 oz. distilled water
4.9 oz. lye/sodium hydroxide

1.1 oz. lemongrass essential oil
1 teaspoon turmeric root powder
1 teaspoon poppy seeds

Soap Notes (in case you want to re-size the batch):

Water as % of oils=33%
7% superfat

This soap recipe will yield 10-12 bars of soap approximately 4 oz. each depending on how they are
cut and fits inside my DIY wooden loaf soap mold.

You can substitute palm kernel oil for the palm kernel flakes in this homemade soap recipe without
having to make adjustments to the amount of lye needed. You can also substitute pomace olive oil for
all or half of the rice bran oil if desired. You won’t need to run this nut free soap recipe back
through a lye calculator if you aren’t resizing the batch or changing it in anyway. However, if you are
resizing the batch for any reason, be sure to run the numbers back through a lye calculator.

The turmeric powder in this homemade soap recipe is used for a natural color to give the soap more of
a yellow pop of color. It is optional. The lemongrass essential oil does make this soap yellow on it’s
own, it’s just not as deep of a yellow color.

Instructions:

Begin by measuring out the distilled water in fluid ounces. Pour into a heat safe pitcher. Next, using a
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digital scale weigh out the lye. Slowly pour the lye into the water in a well ventilated area and stir
until all the lye has dissolved. Set aside to cool.

Now weigh out the palm kernel flakes, palm oil, rice bran oil and castor oil using a digital scale and
combine in a stainless steel pot. Heat until melted, then remove from heat and set aside.

Next weigh out the lemongrass essential oil and set aside. Use a measuring spoon to measure out the
turmeric powder and poppy seeds and set these aside as well until you’re ready to make your soap.

Once the lye-water and soapmaking oils have cooled to around 90°-95°F you’re ready to make soap. 

Add the turmeric powder to the soapmaking oils and mix with a stick blender until fully incorporated.

Now you’ll slowly pour the lye-water into the soapmaking oils. Mix with  a stick blender until you
reach a light trace, then add the essential oil and poppy seeds. Mix again until the soap starts to
thicken again and all ingredients are fully blended into the soap, then pour the soap into your prepared
mold.

Palm oil tends to trace quickly as well as heat up a lot, so I didn’t cover this soap once it was poured
into the mold.

After 24 hours your can unmold your homemade nut free soap loaf and cut it into bars. Allow your
soaps to cure 4-6 weeks before use, then wrap and label as desired.

Coconut Oil Facial Soap Recipe 

This coconut oil facial soap recipe combines ingredients
known for their acne fighting properties making it a
smart choice for those prone to acne! 

It is formulated using refined coconut oil at 100%
with a 20% superfat so it doesn’t over dry skin.
Neem oil, sea buckthorn oil and a blend of essential
oils are also included in this natural homemade soap
recipe to help deter acne naturally. 

Don't just use this homemade coconut oil soap on your
face though. This coconut oil facial soap recipe also
makes for a great body soap.
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Coconut Oil Facial Soap Recipe for Acne Prone Skin

© Rebecca's Soap Delicatessen

Ingredients:

36 oz. refined (76°F melt point) coconut oil

11.8 oz. distilled water
5.2 oz. lye/sodium hydroxide

1.8 oz. 100% neem oil
1 oz. sea buckthorn oil
.5 oz. lavender flower powder
.25 oz. tea tree oil
.5 oz. lemongrass essential oil
.35 oz. patchouli essential oil

Soap Notes (in case you want to re-size the batch):

Water as % of oils=33%
20% superfat

This coconut oil facial soap recipe will yield 10-12 bars of soap approximately 4 oz. each depending on
how they are cut. It fits inside my DIY wooden loaf soap mold.

If you are re-sizing this coconut oil facial soap recipe do so with the coconut oil at 100% of the oils
as the sea buckthorn and neem oils are not included in the lye calculation. In addition the lye amounts
do stay the same if you choose to use unrefined coconut oil instead of refined coconut oil.

Instructions:

Begin by measuring out the distilled water in fluid ounces. Pour into a heat safe pitcher. Next, using a
digital scale weigh out the lye. Slowly pour the lye into the water in a well ventilated area and stir
until all the lye has dissolved. Set aside to cool.

Now weigh out the coconut oil using a digital scale in a stainless steel pot. (You may also want to
weigh out and heat the neem oil at this time as well, especially in colder temps in which neem oil
becomes a semi-solid.) Heat until melted, then remove from heat and set aside. Then wei gh out all of
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the remaining ingredients and set aside.

When the lye-water and soapmaking oils have cooled to around 90°-95°F you’re ready to make soap.

Begin by adding the neem oil, if not previously added to the coconut oil, sea buckthorn oil and lavender
flower powder to the melted oil. Mix with a stick blender until evenly distributed.

Now slowly pour the lye-water into the soapmaking oils. Mix with a stick blender until you reach a
light trace. Add the essential oils and mix again to fully incorporate the oils and bring t o a medium to
full trace. Pour into your prepared soap mold and leave uncovered. (This soap gets very hot during
saponification and the top will crack if you over insulate it.) Set aside for 24 hours.

After 24 hours your can unmold your homemade soap loaf and cut it into bars. Allow bars to cure 4-
6 weeks before use, then wrap and label as desired.

Traditional Castile Soap Recipe

This traditional Castile soap recipe is naturally scented with
basil, lemongrass and rosemary essential oils and is made
using 100% olive oil. However, as 100% olive oil soaps tend
to be a softer soap that takes months to harden, I added a
small amount of sodium lactate to this traditional Castile
soap recipe. I also used a steeper water discount than normal.
This allows you to unmold this Castile soap after a day and
cut it into bars within 24-48 hours. You can, however, omit
the sodium lactate. Just keep in mind it may take a bit
longer to harden up.

Basil, Lemongrass & Rosemary Castile Soap Recipe

© Rebecca's Soap Delicatessen

Ingredients:

36 oz. pomace olive oil

4.5 oz. lye/sodium hydroxide
11 fluid oz. distilled water
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.5 oz. sodium lactate  (60% solution)

.35 oz. basil essential oil

.35 oz. rosemary essential oil

.35 oz. lemongrass essential oil

Soap Notes (in case you want to re-size the batch):

water as % of oils = 30.5%
6% superfat
+/- .5 oz. essential oil per pound of oils

This cold process Castile soap recipe yields 10-12 bars of soap that will weigh around 4 oz. each
depending on how they are cut and fits inside my DIY wooden loaf soap mold.

You can substitute virgin olive oil for the pomace olive, however keep in mind it’s likely to take longer
to reach trace.

Instructions:

Begin by measuring out the distilled water in fluid ounces. Pour into a heat safe pitcher. Next, using a
digital scale weigh out the lye. Slowly pour the lye into the water in a well ventilated area and stir
until all the lye has dissolved. Set aside to cool.

Now weigh out the olive oil using a digital scale and combine in a stainless steel pot. Heat to about
90°-95°F then remove from heat. Prepare you essential oils by weighing them out into a glass Pyrex
measuring cup and set aside.

When the lye-water has cooled to around 90°-95°F – you want the olive oil and lye-water to be
about the same temperature – you’re ready to make soap.

Weigh out the sodium lactate and stir into the cooled lye-water. Now slowly pour the lye-water into
the olive oil. Mix with a stick blender until you reach a light trace. Add the essential oils and combine
with the stick blender until you reach a full trace.

Pour the soap into your prepared mold.

Level the top of the poured soap with needed. Leave uncovered so the soap doesn’t overheat. Set aside
for 24 hours.
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After 24 hours your can unmold your Castile soap loaf. If it’s hard enough, cut it into bars when you
unmold it. If it’s still a bit soft, wait an additional day then cut into bars. Allow bars to cure
anywhere from 4 weeks to 6 months before use. The longer the cure the better the bar. Typically
soaps created using a traditional Castile soap recipe are
cured for 4 to 6 months for best results.

Gardener's Soap Recipe

This homemade gardener's soap recipe is perfect for a
gardener. Not only does it smell amazing but it’s rich, thick
lather and combination of exfoliants really help to scrub
and wash away caked on dirt and grime. It’s also great for
messy artists and crafters as well as mechanics! 

Garden Mint Homemade Soap Recipe

© Rebecca's Soap Delicatessen

Ingredients:

12.8 oz. 76° melt point (refined) coconut oil
6.5 oz. palm oil
13.4 oz. pomace olive oil
2 oz. rice bran oil
1.5 oz. shea butter

5.1 oz. lye/sodium hydroxide
11 fluid ounces distilled water

2 oz. Crafter’s Choice Garden Mint fragrance oil
2 Tablespoons pumice powder
2 Tablespoons poppy seeds
2 Tablespoons apricot kernel meal
1/8-1/4 teaspoon chromium oxide green pigment powder, to suit

Instructions:

To make this gardener's soap recipe simply follow my basic cold process soapmaking instructions adding
the fragrance oil, exfoliants and color at trace.
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This batch will yield approximately 10 – 12 bars (or a 3lb. batch) and will fit inside one of my DIY
wooden loaf soap molds.

Allow bars to cure for 4 – 6 weeks after unmolding and cutting into bars. Wrap your final bars as
desired for gift giving with professional plastic food wrap film and a label, Kraft paper, or even fabric
and a ribbon!

Lanolin Shaving Soap Recipe

This simple homemade shaving soap recipe is great for
beginner soapmakers still getting their feet wet. It combines
some pretty basic oils along with lanolin and marshmallow
root powder for that extra slip. It’s then scented with a
dreamy vanilla and fig fragrance oil.

Vanilla & Fig Shaving Soap Recipe

© Rebecca's Soap Delicatessen

Ingredients:

13.5 oz. pomace olive oil
6.6 oz. palm oil
13 oz. 76°F melt point coconut oil
2 oz. rice bran oil
1.5 oz. refined shea butter
1 oz. lanolin

5.1 oz. sodium hydroxide/lye
12 oz. distilled water

2 oz. vanilla fig fragrance oil
2 Tablespoons marshmallow root powder

Instructions:

This homemade shaving soap recipe will fit into my DIY Wooden Loaf Soap Mold and yield
approximately 10 – 12 homemade soap bars depending on how thick they are cut. To make this
homemade soap recipe follow my basic cold process soapmaking instructions.

http://soapdelinews.com/2012/07/diy-soapmaking-how-to-make-cold-process-soap.html
http://soapdelinews.com/2012/07/diy-soapmaking-how-to-make-cold-process-soap.html
http://www.amazon.com/gp/product/B004NEW94O/ref=as_li_ss_tl?ie=UTF8&camp=1789&creative=390957&creativeASIN=B004NEW94O&linkCode=as2&tag=rebeccassoapd-20
http://www.amazon.com/gp/product/B0024NM1H6/ref=as_li_ss_tl?ie=UTF8&camp=1789&creative=390957&creativeASIN=B0024NM1H6&linkCode=as2&tag=rebeccassoapd-20
http://soapdelinews.com/2013/06/how-to-make-a-soap-mold-for-cold-process-soap.html
http://edge.affiliateshop.com/public/AIDLink?AID=021074&Redirect=/products/marshmallow-root-powder/profile
http://www.wholesalesuppliesplus.com/ProductDetail.aspx?CatalogID=4&GroupID=3&CategoryID=135&ProductID=8077&ProductName=Crafters+Choice%E2%84%A2+Vanilla+Fig*+Fragrance+Oil+652
http://www.amazon.com/gp/product/B001EDBEZM/ref=as_li_ss_tl?ie=UTF8&camp=1789&creative=390957&creativeASIN=B001EDBEZM&linkCode=as2&tag=rebeccassoapd-20
http://www.amazon.com/gp/product/B000I1OYNK/ref=as_li_tl?ie=UTF8&camp=1789&creative=390957&creativeASIN=B000I1OYNK&linkCode=as2&tag=rebeccassoapd-20&linkId=L2WC4GNGUQ5S67DE
http://www.amazon.com/gp/product/B00BW3AWFW/ref=as_li_tl?ie=UTF8&camp=1789&creative=390957&creativeASIN=B00BW3AWFW&linkCode=as2&tag=rebeccassoapd-20&linkId=5TVBHTGB3XDECXNE
http://www.amazon.com/gp/product/B007ZN5MTE/ref=as_li_tl?ie=UTF8&camp=1789&creative=390957&creativeASIN=B007ZN5MTE&linkCode=as2&tag=rebeccassoapd-20&linkId=EWSDEHDODWVBWO66
http://www.amazon.com/gp/product/B005CW3MB0/ref=as_li_tl?ie=UTF8&camp=1789&creative=390957&creativeASIN=B005CW3MB0&linkCode=as2&tag=rebeccassoapd-20&linkId=2KKX65DNCHYRN7PJ
http://www.amazon.com/gp/product/B00563E6ZG/ref=as_li_tl?ie=UTF8&camp=1789&creative=390957&creativeASIN=B00563E6ZG&linkCode=as2&tag=rebeccassoapd-20&linkId=EMP5P5TAIJBEIFHB
http://www.amazon.com/gp/product/B00C7VTWRM/ref=as_li_tl?ie=UTF8&camp=1789&creative=390957&creativeASIN=B00C7VTWRM&linkCode=as2&tag=rebeccassoapd-20&linkId=L4WRNA5LWXDOE4UV
http://www.soapdelicatessen.com/


Prepare and mix the lye-water using a digital scale to weigh out the ingredients. Set aside to cool.

Now weigh out the soapmaking oils, shea butter and lanolin and combine in stainless steel (non-
aluminum) pot. Heat on the stovetop over medium heat until all the ingredients have melted, then
remove from heat and allow to cool.

Once both the lye-water and soapmaking oils have cooled to around 95°-100°F you can mix the two
together using a stick blender. At light trace add the fragrance oil and marshmallow root powder and
mix well to fully incorporate both the fragrance and powder, then pour into your prepared mold. Keep
in mind that this fragrance oil will turn the soap a dark brown due to its vanilla content.

Cover and insulate the soap loaf for 24 hours, then unmold and cut into bars. Wrap and label as
desired.

Homemade Bacon Soap Recipe

This homemade bacon soap recipe is the perfect DIY
gift idea for men who love bacon! And what better
way to say “I love you” than with a bar of heart
shaped bacon soap? 

Made using real bacon (rendered) fat, this homemade
bacon soap recipe yields nine hard, extra conditioning
homemade soap bars perfect for the shower! So there
are plenty to go around to all of your bacon loving
friends. Scent this homemade bacon soap with a bacon
fragrance oil or your sweetheart’s favorite scent –
your choice!

Homemade Bacon Soap Recipe

© Rebecca's Soap Delicatessen

Ingredients:

8.75 oz. bacon fat, rendered (lard, pig tallow in soap calc)
5 oz. 76° melt point refined coconut oil
3.75 oz. castor oil
7.5 oz. pomace olive oil, (virgin olive oil is ok too!)

http://edge.affiliateshop.com/public/AIDLink?AID=021074&Redirect=/products/olive-oil-organic-extra-virgin/profile
http://www.amazon.com/gp/product/B00C7VTWRM/ref=as_li_tl?ie=UTF8&camp=1789&creative=390957&creativeASIN=B00C7VTWRM&linkCode=as2&tag=rebeccassoapd-20&linkId=L4WRNA5LWXDOE4UV
http://edge.affiliateshop.com/public/AIDLink?AID=021074&Redirect=/products/castor-oil/profile
http://edge.affiliateshop.com/public/AIDLink?AID=021074&Redirect=/products/coconut-oil-refined/profile
http://www.soapdelicatessen.com/
http://www.amazon.com/gp/product/B006JXXBZ8/ref=as_li_ss_tl?ie=UTF8&camp=1789&creative=390957&creativeASIN=B006JXXBZ8&linkCode=as2&tag=rebeccassoapd-20
http://www.amazon.com/gp/product/B001NE0FU2/ref=as_li_ss_tl?ie=UTF8&camp=1789&creative=390957&creativeASIN=B001NE0FU2&linkCode=as2&tag=rebeccassoapd-20


8.25 fluid oz. distilled water
3.5 oz. sodium hydroxide/lye

1.5 oz. fragrance oil of choice

Soap Notes (in case you want to re-size the batch):

water as % of oils – 33%
fragrance oil used at 1 oz. per pound
8% superfat

Instructions:

You’ll need to begin by rendering your bacon fat. Basically all this means is you’ll need to cook up a
bunch of bacon and save the grease that’s left at the end. I saved up my bacon grease over many
weekend morning breakfasts in cups in the fridge. Once you have the necessary amount, heat and
strain out the tiny bits of bacon that may have snuck in.

For the rest of the bacon soap recipe you’ll need to follow my basic cold process soapmaking
instructions. You’ll also need two Wilton 6-Cavity Silicone Heart Molds.

Begin by preparing the lye-water. Measure out the distilled water into a pitcher. Then, using a digital
scale, weigh out the lye. Slowly pour the lye into the water in a well ventilated area and stir until the
lye has fully dissolved. Set aside to cool.

Now prepare the soapmaking oils by weighing out the bacon fat, coconut oil, castor oil and olive oil into
a large stainless steel pot. Heat on the stove over medium heat until all of the oils have melted then
remove from heat and set aside.

While you are waiting for the oils and lye-water to cool you can go ahead and weigh out the fragrance
oil. For this particular homemade soap recipe I used Nature’s Garden Cracklin Birch fragrance oil. It
does accelerate trace a bit but nothing too crazy and it stills smells great once it goes through the
soap’s saponification process. Alternately Nature’s Garden also sells a Bacon fragrance oil if you’re
looking for an authentic bacon scented soap. You can also use your own favorite fragrance oil or leave
this soap unscented. (This soap will NOT smell like bacon unless you use a bacon fragrance oil.
Promise.)

Once the lye-water and oils have cooled to around 95°-100°F you’re ready to make soap. Slowly pour
the lye-water into the soapmaking oils and mix with a stick blender until you reach a light trace. Add

http://www.amazon.com/gp/product/B006JXXBZ8/ref=as_li_ss_tl?ie=UTF8&camp=1789&creative=390957&creativeASIN=B006JXXBZ8&linkCode=as2&tag=rebeccassoapd-20
http://www.naturesgardencandles.com/candlemaking-soap-supplies/item/bacon/-bacon-fragrance-oil.html
http://www.naturesgardencandles.com/candlemaking-soap-supplies/item/rf-aa6/-cracklin-birch-fragrance-oil.html
http://www.amazon.com/gp/product/B001NE0FU2/ref=as_li_ss_tl?ie=UTF8&camp=1789&creative=390957&creativeASIN=B001NE0FU2&linkCode=as2&tag=rebeccassoapd-20
http://www.amazon.com/gp/product/B001NE0FU2/ref=as_li_ss_tl?ie=UTF8&camp=1789&creative=390957&creativeASIN=B001NE0FU2&linkCode=as2&tag=rebeccassoapd-20
http://www.amazon.com/gp/product/B000M9OBPY/ref=as_li_ss_tl?ie=UTF8&tag=rebeccassoapd-20&linkCode=as2&camp=1789&creative=390957&creativeASIN=B000M9OBPY
http://www.amazon.com/gp/product/B001EDBEZM/ref=as_li_ss_tl?ie=UTF8&camp=1789&creative=390957&creativeASIN=B001EDBEZM&linkCode=as2&tag=rebeccassoapd-20


the fragrance oil and mix thoroughly until you reach about a medium trace. You don’t want the soap
to thicken too much or you’ll have trouble filling your mold cavities so there are no air bubbles or
pockets.

Now pour the soap evenly into nine of the mold cavities. This will fill one mold completely and half of
the second mold. Cover the mold with cling wrap or food service film.

My homemade bacon soaps were ready to unmold the next day. However if you live in a particularly
humid area you may want to wait an additional day before unmolding to ensure your soaps come out
of the molds cleanly.

Once you’ve unmolded your heart shaped bacon soaps set them aside to cure for 4-6 weeks. Then
wrap and label as desired for gifting.

Easy Goat Milk Soap Recipe

Not only is this goat milk soap perfect for those
who allergic to fragrances, but it also makes a great
facial soap. Plus it’s skin conditioning ingredients are
perfect for those who suffer from dry or maturing
skin. This homemade unscented goat milk soap
recipe uses a simplified process for making goats
milk soaps by calling for goat milk powder in lieu of
fresh goat milk to help ensure success even for a
first time soapmaker.

Rebecca's Best Ever Goat Milk Soap Recipe

© Rebecca's Soap Delicatessen

Ingredients:

1.6 oz. cocoa butter
1.6 oz. shea butter
12.6 oz. palm kernel flakes
5.8 oz. palm oil
7.2 oz. rice bran oil
7.2 oz. olive oil

http://edge.affiliateshop.com/public/AIDLink?AID=021074&Redirect=/products/olive-oil-organic-extra-virgin/profile
http://www.amazon.com/gp/product/B0009PAVQY/ref=as_li_ss_tl?ie=UTF8&camp=1789&creative=390957&creativeASIN=B0009PAVQY&linkCode=as2&tag=rebeccassoapd-20
http://www.amazon.com/gp/product/B00GO5MEZY/ref=as_li_tl?ie=UTF8&camp=1789&creative=390957&creativeASIN=B00GO5MEZY&linkCode=as2&tag=rebeccassoapd-20&linkId=7YEN4FQXJFTKTI5W
http://www.amazon.com/gp/product/B00AZ0TMA4/ref=as_li_ss_tl?ie=UTF8&camp=1789&creative=390957&creativeASIN=B00AZ0TMA4&linkCode=as2&tag=rebeccassoapd-20
http://edge.affiliateshop.com/public/AIDLink?AID=021074&Redirect=/products/shea-butter/profile
http://edge.affiliateshop.com/public/AIDLink?AID=021074&Redirect=/products/cocoa-butter-organic-and-fair-trade/profile
http://www.soapdelicatessen.com/
http://www.amazon.com/gp/product/B00629LVXI/ref=as_li_ss_tl?ie=UTF8&camp=1789&creative=390957&creativeASIN=B00629LVXI&linkCode=as2&tag=rebeccassoapd-20


11.8 fluid oz. distilled water
5 oz. sodium hydroxide/lye

2 Tablespoons plus 2 teaspoons goat milk powder
2 Tablespoons plus 2 teaspoons colloidal oatmeal

Instructions:

This homemade shaving soap recipe will fit into my DIY Wooden Loaf Soap Mold and yield
approximately 10 – 12 homemade soap bars depending on how thick they are cut. To make this
homemade soap recipe follow my basic cold process soapmaking instructions.

To incorporate the goats milk powder, you will need to follow my article on "How to Make Goats Milk
Soap the Easy Way" located here. Once your melted soapmaking oils and lye-water have cooled to
around 90°F, you will measure out and add the goats milk powder and colloidal oatmeal to your cooled
oils BEFORE you add the lye-water. Use your stick (immersion) blender to mix thoroughly. Once these
ingredients have dissolved, then you can mix in the lye-water.

At trace, pour the soap into your lined mold, then cover and insulate for 24 hours. If you wish to use
a fragrance, you can add up to 2 oz. of fragrance oil or up to 1.5 oz. of essential oils at trace. Once
you unmold your soaps, cut into bars, and allow soaps to cure for a minimum of four to six weeks
before using.

Easy Mango & Coconut Milk Soap Recipe

© Rebecca's Soap Delicatessen

Ingredients:

21.6 oz. palm oil
3.6 oz. palm kernel flakes
7.2 oz. 76° melt point refined coconut oil
7.2 oz. rice bran oil

8.8 fluid oz. distilled water
5 oz. lye/sodium hydroxide

3 oz. pureed ripe mango
½ Cup coconut milk powder

http://soapdelinews.com/2013/06/diy-soap-cutter-a-simple-guide-for-cutting-your-soap-into-bars.html
http://www.amazon.com/gp/product/B00QIVB19Y/ref=as_li_tl?ie=UTF8&camp=1789&creative=390957&creativeASIN=B00QIVB19Y&linkCode=as2&tag=rebeccassoapd-20&linkId=JG72A6PF5AL6VORI
http://www.amazon.com/gp/product/B001EDBEZM/ref=as_li_ss_tl?ie=UTF8&camp=1789&creative=390957&creativeASIN=B001EDBEZM&linkCode=as2&tag=rebeccassoapd-20
http://www.amazon.com/gp/product/B007ZN5MTE/ref=as_li_tl?ie=UTF8&camp=1789&creative=390957&creativeASIN=B007ZN5MTE&linkCode=as2&tag=rebeccassoapd-20&linkId=CIHFGXWE5T42JSPQ
http://edge.affiliateshop.com/public/AIDLink?AID=021074&Redirect=/products/coconut-oil-refined/profile
http://www.amazon.com/gp/product/B00LWBMIHO/ref=as_li_tl?ie=UTF8&camp=1789&creative=390957&creativeASIN=B00LWBMIHO&linkCode=as2&tag=rebeccassoapd-20&linkId=NCSCYQZF7WKBPCM7
http://www.amazon.com/gp/product/B00GO5MEZY/ref=as_li_tl?ie=UTF8&camp=1789&creative=390957&creativeASIN=B00GO5MEZY&linkCode=as2&tag=rebeccassoapd-20&linkId=7YEN4FQXJFTKTI5W
http://www.soapdelicatessen.com/
http://soapdelinews.com/2013/06/how-to-make-homemade-goat-milk-soap-the-easy-way.html
http://soapdelinews.com/2013/06/how-to-make-homemade-goat-milk-soap-the-easy-way.html
http://soapdelinews.com/2013/06/how-to-make-a-soap-mold-for-cold-process-soap.html
http://www.amazon.com/gp/product/B001EDBEZM/ref=as_li_ss_tl?ie=UTF8&camp=1789&creative=390957&creativeASIN=B001EDBEZM&linkCode=as2&tag=rebeccassoapd-20


2-2.25 oz. fragrance oil, optional

Soap Notes (in case you want to re-size the batch):

The water as percent of the oil weight is 33% with the water then discounted by the amount of
mango used in this homemade soap recipe.

The mango accounts for approximately 8.3% of the total oil weight.

This mango & coconut milk soap recipe was calculated using 6% superfat.

You can use a fragrance oil for this cold process soap recipe. If desired use up to 2.25 oz. of your
favorite body safe fragrance oil; half for essential oils. 

This mango & coconut milk cold process soap recipe will yield 10-12 bars of soap approximately 4 oz.
each depending on how they are cut and fits inside my .

Instructions:

Begin by measuring out the distilled water in fluid ounces. Pour into a heat safe pitcher. Next, using a
digital scale weigh out the lye. Slowly pour the lye into the water in a well ventilated area and stir
until all the lye has dissolved. Set aside to cool.

Now weigh out the soapmaking oils using a digital scale and combine in a stainless steel pot. Heat until
melted, then remove from heat and set aside.

Next, dice the mango, weigh, and set aside. In a separate container using a measuring cup to measure
out the coconut milk powder and set aside. If using a fragrance oil, weigh out the oil at this time as
well and set aside.

When the lye-water and soapmaking oils have cooled to around 90°-95°F you’re ready to make soap.

Add the mango chunks and the coconut milk powder to the pot of melted soapmaking oils. Use a stick
blender to puree the mango into the oils and incorporate the coconut milk powder. Once the mango and
coconut milk powder are fully incorporated in the oils with no chunks you are ready to mix in the lye-
water.

Slowly pour the lye-water into the soapmaking oils. Mix with a stick blender until you reach trace. If
you are using a fragrance add the fragrance oil at a light trace then mix fully until the fragrance is
fully incorporated and you get a medium trace on the soap.

http://www.amazon.com/gp/product/B006JXXBZ8/ref=as_li_ss_tl?ie=UTF8&camp=1789&creative=390957&creativeASIN=B006JXXBZ8&linkCode=as2&tag=rebeccassoapd-20
http://www.amazon.com/gp/product/B001N07KUE/ref=as_li_ss_tl?ie=UTF8&camp=1789&creative=390957&creativeASIN=B001N07KUE&linkCode=as2&tag=rebeccassoapd-20
http://www.amazon.com/gp/product/B001N07KUE/ref=as_li_ss_tl?ie=UTF8&camp=1789&creative=390957&creativeASIN=B001N07KUE&linkCode=as2&tag=rebeccassoapd-20


Pour the soap batter into your prepared soap mold and leave uncovered. (This soap gets very hot during
saponification and the top will crack if you over insulate it.) Set aside for 24 hours.

After 24 hours your can unmold your homemade soap loaf and cut it into bars. Allow bars to cure at
least four weeks then wrap with foodservice film and label.

How to Make Soap Labels

Want to make your own custom soap labels but aren't sure where to start? Follow this easy tutorial
that uses the free, open source word processing program OpenOffice. OpenOffice works across all
operating systems regardless of whether you have a Mac or a Windows PC. In addition to this word
processing program, you’ll also need clipart for your label image or images. These can be images you've
created yourself or ones that you've purchased.

For the purpose of this tutorial I used antler clipart with floral decoration from The Dutch Lady
Designs. I am making custom wedding soap favor labels for this particular tutorial. However, you can
easily change the information you provide on your label using the same steps provided here.

Have your clip art image(s)? Let's get started!

First determine the size of your soaps. My soaps, created from my DIY wooden loaf soap mold creates
bars that are approximately 3 ¼ in. x 2 ½ in. Once you know what size your soaps will be you can
then create your soap labels. You’ll need to create the labels slightly smaller than the size of the soap.

https://www.etsy.com/shop/TheDutchLadyDesigns
https://www.etsy.com/shop/TheDutchLadyDesigns
https://www.etsy.com/listing/211357436/antler-clipart-with-floral-decorations
https://www.openoffice.org/
http://www.amazon.com/gp/product/B00629LVXI/ref=as_li_ss_tl?ie=UTF8&camp=1789&creative=390957&creativeASIN=B00629LVXI&linkCode=as2&tag=rebeccassoapd-20


1. Begin by creating a new text document. File > New > Text Document.

2. Next, create two columns. Format > Columns Click on the image with two columns. Change the
spacing to at least .10 in. then hit OK.

3. The numbers at the top of the page indicate the inches across the page. You can slide the little
arrow guides into place so that they are the width you’d like your soap labels to be to ensure you
make them the size you want them. There are also inches that run vertically down the side of the
text document you stay within your height constraints.



4. Now import your image you want to use for the labels. Insert > Picture from file > Choose the
image from your computer’s location. Right click on the image then choose Wrap > In Background

5. Right click on the image again and choose Arrange > Send to back

6. With the image selected – you’ll see the green boxes around the image when its selected – left
click on your mouse and drag the image slightly down the page to allow room for text above it.

7. Now choose your font for your labels from the drop box at the top along with the size directly to
the right.



8. Center the text – or choose left or right alignment based on how you want your soap labels for
your DIY wedding soap favors to look – then type in your text. Choose whatever text you like based
on whether you’re created wedding soap favors or save the date soaps.

9. If you’d like a frame around the label you can create one as well. Go to Insert > Frame then hit
OK on the box that pops up. Right click on the frame and hit Wrap > In Background then right click
again and choose Arrange > Send to back.



10. Now left click on your mouse over one of the green squares and drag the frame out around your
image and text until its place where you’d like it.

11. Select the line style for your frame if desired from the drop down Line Style drop box.



12. You can also choose a color for your frame from the drop down Border Color drop box.

13. Now select the label you’ve just created using your mouse and then hit either CTL C (on
Windows) or COMMAND C (on Mac) to copy the label.



14. Now hit enter under the label design to add two spaces under the image.

15. Hit CTL V (on Windows) or COMMAND V (on Mac) to paste a second label below the first.

16. Repeat until you’ve filled the page. 



17. Then simply print out your sheet of soap labels onto a full size label sheet from World Label. 

18. Finally cut out your labels and adhere to your wrapped bars of soap.

Helpful Soapmaking Resources & References

Now that you know how to make homemade cold process soaps, here are a few links to soapmaking
suppliers, lye calculators and other helpful websites, tools and charts you may need during your
soapmaking journey.

Soapmaking Suppliers:

Mountain Rose Herbs
Wholesale Supplies Plus
Nature's Garden Candles
Brambleberry Soap Making Supplies
Soaper's Choice 
Bulk Apothecary
The Chemistry Store
Camden-Grey Essential Oils
From Nature with Love
Mad Oils
Ponte Vedra Soap Shoppe

Lye Calculators:

SoapCalc Lye Calculator 
Bramble Berry Lye Calculator 
Majestic Mountain Sage Lye Calculator
Pine Meadows Lye Calculator

http://www.pinemeadows.net/lyecalc.php
http://www.thesage.com/calcs/lyecalc2.php
http://www.brambleberry.com/Pages/Lye-Calculator.aspx
http://www.soapcalc.net/calc/SoapCalcWP.asp
http://www.pvsoap.com/
http://www.madoils.com/
https://www.fromnaturewithlove.com/
http://www.camdengrey.com/
http://www.chemistrystore.com/
http://www.bulkapothecary.com/
https://www.soaperschoice.com/
http://www.brambleberry.com/
http://www.naturesgardencandles.com/
http://www.wholesalesuppliesplus.com/
http://www.mountainroseherbs.com/index.php?AID=021074
http://www.worldlabel.com/Pages/wl-ol175.htm


Tools & Charts & Soapy DIY's:

Weight Conversion and Percentage Calculator
Chart with Properties of Soapmaking Oils
Additional Chart with Properties of Soapmaking Oils
Non-comedogenic Chart
FDA Cosmetics Handbook
How to Re-size a Batch of Cold Process Soap
How to Line a Wooden Soap Mold
How to Make a Wood Loaf Soap Mold
How to Make a Loaf Soap Cutter
DIY Ideas for Soap Labels
Large Collection of Cold Process Soap Recipes
How to Add Milk to Lye for CP Milk Soaps
Understanding Glycerin Rivers in CP Soap
Understanding Gel Phase
Calculating the Amount of Soap to Fill a Soap Mold
Soapmaking Oils Chart with Properties & Notes on Breaking the “Rules”
How to Start Your Own Soap Business

This PDF book is © 2015 Rebecca D. Dillon, owner of Rebecca's Soap Delicatessen and Soap Deli News
Blog. If you'd like to learn more about soapmaking as well as discover more of my homemade soap
recipes, please follow my blog on Blog Lovin' and Tumblr as well as following me on Pinterest,
Facebook, Twitter, G+ and Instagram. 

Disclaimer: This content is provided for informational purposes only. I make no representations as to
the accuracy or completeness of any information on this site or found by following any link on this
site. You as an end user are responsible for all end products made by you from the recipes provided on
this site.

As the author of this PDF book, I will not be liable for any errors or omissions in this information nor
for the availability of this information. Likewise I will not be liable for any losses, injuries, or
damages from the display or use of this information.

http://blog.worldlabel.com/2010/how-to-start-your-own-soap-business.html
http://www.lovinsoap.com/oils-chart/
http://instagram.com/soapdeli
https://plus.google.com/+Soapdelicatessen
http://www.twitter.com/soapdeli
http://www.facebook.com/soapdeli
http://www.pinterest.com/soapdeligirl/
http://soapdeli.tumblr.com/
http://www.bloglovin.com/blog/2552134/soap-deli-news
http://soapdelinews.com/
http://soapdelinews.com/
http://www.soapdelicatessen.com/
http://candleandsoap.about.com/od/suppliers/tp/Calculating-The-Size-Amount-Of-Soap-To-Fill-A-Soap-Mold.htm
http://www.soapqueen.com/bath-and-body-tutorials/tips-and-tricks/gel-phase/
http://auntieclaras.com/2014/05/glycerine-rivers-secret-revealed/
http://www.soapqueen.com/bath-and-body-tutorials/tips-and-tricks/how-to-add-lye-to-milk-for-cold-process-soap/
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